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      命令历史窗口 

                  

        命令窗口：直接输入程序语言和输出结果 

菜单栏 

工具栏 

系统光标输入符 

MatLab 入门 

２.１ MatLab 软件基础介绍 

 

MatLab 是 Matrx Laboratory 的缩写，意为矩阵实验室。MatLab 语言是

由美国的 Clever Moler 博士于 1980 年研发的，1984 年由美国 Math Works

公司推向市场。历经三十多年的发展与竞争，现成为国际公认的最好的科

学计算和工程应用开发环境。在数学建模活动中，由于 MatLab 的语法规则

简单、贴近人的思维方式，使得 MatLab 软件深受广大师生的欢迎。常用的

主要功能有： 

1. 数值计算功能； 

2. 符号计算功能； 

3. 数据分析和可视化功能：执行统计数据的分析和处理，绘制图形； 

4. 可扩展功能：编写 M 文件开发自己的应用程序，程序调试和修改方

便、简单，人机交互性强。 

 

2.1.1  MatLab 界面操作介绍 

安装 MatLab 软件后，双击电脑桌面 MatLab 快捷方式图标，就能进行

MatLab 界面操作窗口，见示意图 2-1。 

 

 

图 2-1  MatLab 界面操作窗口 

 

MatLab 常用输入输出窗口有三个，分别是： 
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1. 命令窗口：是输入和输出窗口。窗口见图 2-1。 

若输入或输出数据很多，在命令窗口不好查看或者复制，则可在

“Workspace”中查看。 

2. M 文件窗口：是输入窗口，输出结果在命令窗口或图形窗口显示。 

打开 MatLab 界面操作窗口后，单击菜单栏中的“File”菜单，在选项

“New”子目录下单击“M-File”，即可打开 M 文件。在 M 文件可进行输

入、调试或修改程序，见图 2-2。 

 

    

    

 

 

 

 

 

  

 

    图 2-2  M 文件操作窗口               图 2-3  图形显示窗口 

 

3. 图形显示窗口：是输出窗口。运行作图程序命令就是弹出可视图形显示

窗口和所作的图形，见图 2-3。 

 

2.1.2  MatLab 输入窗口 

命令窗口和 M 文件窗口都是程序命令输入窗口，区别在于： 

1. 命令窗口输入一行程序后，按“Enter”键就进入下一行的输入或者输出

结。命令窗口的不便之处： 

（1）按了“Enter”键后，不能修改前面的程序命令； 

（2）历史记录只存在命令历史窗口中，查找不便。 

2.  M 文件窗口同样可以输入程序，程序输入比命令窗口更灵活，可以对

程序进行任意修改、调试；还可以重命名保存便于事后查找和调用。 

程序运行的操作有两种方法： 
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图 2-4  M 文件运行操作步骤示意图 

（1）单击 M 文件菜单栏中的“Debug”，单击其目录下的“run”，结果就

会显示在命令窗口或图形窗口中，见图 2-4。 

（2）直接单击运行快捷键，见图 2-4。 

 

2.2  MatLab 语言规则 

 

MatLab 语言都是在英文半角状态下输入的，注意以下几点： 

1. 都是区分大小写的，内部命令和函数都是小写的； 

2. 一行可以输入多个命令，命令之间用逗号“,”（显示结果）或“;”（不

显示结果）间隔； 

3. 百分号“%”表示注释符，百分号“%”后面的内容为注解（可写中文），

不参与运行。 

4.  MatLab 常用的数据类型有变量和常量： 

（1）常量表示：常量与数学的数值表示一致，采用十进制和科学计数法表

示； 

如： 1，-2.3， 6.21e+15 表示 6.21×1015， 3.8e-12 表示 3.8×10-12
 

（2）变量表示：MatLab 的变量命名必须遵循以下规则--变量名由字母、数

字和下划线“-”构成，且必须以字母开头；并且区分大小写；长度不能超过

31 个字符。 

如：a,   x1,  y_5  都是有效的变命名。 

注意：MatLab 系统内部有预定义的变量，常用的预定义变量见表 2-1，

所以给变量命名时应避免使用已有的预定义变量，否则在计算时会出现混

乱。 

表 2-1  MatLab 常用的预定义变量 

预定义变量 变量的含义 

ans 缺省变量名的表达式的结果变量名 

Inf 或 inf 无穷大,  1/0 
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pi 圆周率π 

i, j 虚数单位，sqrt(-1) 

NaN 无法定义的一个数目 0/0 

clc 清除命令窗口显示的内容 

clear 清除命令窗口的所有内存变量 

clf 清除当前图形窗口的图像 

 

5. MatLab 语句表达式--赋值 

MatLab 语句是由表达式和变量组成，常见的两种语句表示形式： 

（1）表达式 

（2）变量=表达式 

其中，表达式由运算符（加减乘除等）、变量、函数（如三角函数）、

和数字构成，与“手写算式”基本相同。两种表达形式的区别请看表 2-2。 

 

表 2-2  两种语句表达式的例子比较 

 （1）表达式 （2）变量=表达式 

输入 >> 2*5 >> y=2*5 

输出 ans =10 y = 10 

 

这里 ans 是指当前的计算结果。如果用户没有对表达式设定变量，

MatLab 自动将当前结果赋值给 ans 变量。 

对于简单表达式的计算，直接输入简单快速；而当表达式比较复杂或

需多次使用时，最好就是先定义变量，以便后面的引用。例如： 

>> y=2*5; 

>> z=y+12 

   z=22 

 

2.3 数值计算功能 

MatLab 具有强大的数值计算功能，本节将介绍数、数组、矩阵的创建

及运算，方程组的求解等。 

 

2.3.1  常用运算符 

 

1. 基本运算符 
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在 MatLab 中，一般的代数表达式的输入就如同在纸上演算一样，所以

有人称其为演算纸式的科学计算语言。数学的加、减、乘、除、乘方运算

符见表 2-3 

表 2-3  MatLab 基本运算符 

数学符号名称 MatLab 的运算符表示 例如 

加 ＋ + 2+5 

减 － - 2-5 

乘  × * 2*5 

除  ÷ / 2/5 

乘方 2
5
 ^ 2^5 

 

注意： 

（1）在 MatLab 中，任何运算符都不能省略，特别是乘号，很多同学

会习惯性的按手写规则省略不写，省略后会出错。 

（2）在 MatLab 中，没有专门的开方运算符，需将开方转化成乘方计

算。例如：数学计算公式 3 5x ，化为乘方的幂运算式子为 3

1

5x ，则需在

MatLab 命令窗口中输入： 

>> x=5^(1/3) 

（3）MatLab 运算优先级与手写演算一样：从上往下，从左往右，有

括号先算括号，先乘方、再乘除、后加减。 

【例 3-1】 用 MatLab 计算
532

101


y  

在 MatLab 命令窗口输入>>  y=101/(2*3^5) 

按 Enter 键输出结果为   

                         y= 0.2078 

 

2. 三角函数运算符 

 

三角函数在角度计算时常常出现，MatLab 的三角函数表达式与数学表

达式稍有不同，其具体表示见表 2-4 

 

表 2-4  MatLab 三角函数表达式 

数学表达式 MatLab 表达式 数学表达式 MatLab 表达式 

sinx sin(x) arcsinx asin(x) 
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cosx cos(x) arccosx acos(x) 

tanx tan(x) arctanx atan(x) 

 

注意：MatLab 的三角函数表达式中的角度必须是弧度，因此需要用到角度

转化为弧度的公式： 


 
180

 

【例 3-2】 用 MatLab 计算  45sina  

在 MatLab 命令窗口输入>>  a=sin(45/180*pi) 

按 Enter 键输出结果为   

                         a= 0.7071 

 

3. 其他常用运算符的表示 

在计算中，还时常会用到绝对值、对数、自然数等运算，对应的 MatLab

表达式见表 2-5. 

表 2-5  其他常用运算符对应的 MatLab 表达式 

 

数学表达式 MatLab 表达式 数学表达式 MatLab 表达式 

绝对值|x| abs(x) 以 e 为底 lnx log(x) 

自然数 e exp(1) 以 2 为底 log2x log2(x) 

e
x
 exp(x) 以 10 为底 log10x log10(x) 

 

注意：MatLab 的对数表达式中只有以自然数 e、2 或 10 这三种为底，其它

底的对数运算需用到换底公式：
a

b

a

b

a

b
bga

ln

ln

log

log

log

log
lo

10

10

2

2 或或  

【例 3-3】 用 MatLab 计算 2

3 5log ex   

在 MatLab 命令窗口输入>>  x=abs(log2(5)/log2(3)-exp(2)) 

按 Enter 键输出结果为   

                         x= 5.9240 

 

4. 取整运算符 

MatLab 中有四个不同的取整命令，分别为：fix、floor、ceil 和 round。

具体使用方法见表 2-6 

表 2-6  MatLab 取整命令 
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命令 意义 以 3.6 为例 以-3.6 为例 

fix 截尾取整(朝零方向取整） 3 -3 

floor 朝负无穷大方向取整 3 -4 

ceil 朝正无穷大方向取整 4 -3 

round 四舍五入取整 4 -4 

 

注意：MatLab 可以同时对多个数进行取整。 

【例 3-4】对 3.2，-5.8，9.4 进行四舍五入取整； 

在 MatLab 命令窗口输入>>  a=round([3.2,-5.8,9.4]) 

按 Enter 键输出结果为   

                         a= 3   -6    9 

这里多个数用到数组或矩阵的表示，详细表示方法见后面介绍。 

 

5.  MatLab 精度表示方法 

在 MatLab 中，输出数据默认显示 4 位小数点，但是在很多计算中需要

更高的精度以降低误差，因此需根据实际需要设置显示小数点的位数。

MatLab 输出格式由 format 命令控制，常用的精度命令使用方法见表 2-7. 

 

表 2-7  MatLab 中精度命令的使用方法 

命令 意义 以π为例输入 输出 

format short 4 位小数点 pi 3.1416 

format long 14 位小数点 pi  3.14159265358979 

vpa(pi,n) 对π取 n位有效数 vpa(pi,6) 3.14159 

 

注意：在用 MatLab 中的输出格式命令 format 时，必须单独写一行，且不加

任何符号，format 与后面的 short 或 long 命令以空格间隔。 

 

【例 3-5】对π保留 14位小数点； 

在 MatLab 命令窗口输入 >>  format long 

                      >>     pi      

按 Enter 键输出结果为  3.14159265358979 

 

2.3.2  数组及其运算 

本书的数组都表示一维数组，且该数组都默认是按行写的，而二维数

组称为矩阵。数组在实际中被广泛应用。 



 
 8 

 

1. 数组的创建 

 

MatLab 创建数组的方法有： 

（1）直接输入数组 

直接一一列举所有的元素，所有元素必须放在中括号“[ ]”里面，元

素与元素之间有空格（空格数不限）或逗号间隔。 

【例 3-6】 用直接创建法输入 2，4，6，8，10 构成的数组。 

在 MatLab 命令窗口输入>> a=[2,4,6,8,10] 

按 Enter 键输出结果为    a= 2     4     6     8    10 

（2）用冒号“:”表达式创建数组 

若创建等差数列的数据时，可以用冒号“:”快速创建数组，这种创建

方法不需要用到中括号“[ ]”。表达式的基本格式为： 

变量=第一个数值(首项):步长(等差数列的公差):最后一个数值(末项) 

【例 3-7】 用冒号法创建 2，4，6，8，10 构成的数组。 

在 MatLab 命令窗口输入>> a=2:2:10 

    按 Enter 键输出结果为    a= 2     4     6     8    10 

注意：当步长为 1 时可省略不可，如 b=2:1:5 可简写为 b=2:5 

（3）用 linspace 创建数组 

在 MatLab 中，可用 linspace 来生成线性等分的数组，表达式的基本格

式为： 

变量=linspace(第一个数值,最后一个数值,等分数) 

【例 3-8】 用 linspace 创建 2，4，6，8，10 构成的数组。 

在 MatLab 命令窗口输入>> a=linspace(2,10,5) 

按 Enter 键输出结果为    a= 2     4     6     8    10 

 

2. 数组元素的访问 

 

在运算或者编写程序时会访问数组中某一个（或一部分）元素，访问

数组元素具体表示如下 

(1)  访问一个元素的格式为： 

     b=a(i)  %访问数组 a 中的第 i 个元素，并赋值给 b 

(2)  访问一部分元素(有规律)的格式为： 

     c=a(i:1:j)  %访问数组 a 中的第 i 个元素至第 j 个元素，并赋值给 c 

(3)  指定访问几个位置元素的格式为： 

     d=a([i,j,k])  %访问数组 a 中第 i、j 和 k 个元素，并赋值给 d 
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【例 3-8】 数组的访问 

在 MatLab 命令窗口输入>> a=2:2:30 

                     >> b=a(2) 

                     >> c=a(4:2:12) 

                     >> d=a([1,5,2,16]) 

按 Enter 键输出结果为 

  a= 2  4  6  8   10  12  14  16  18  20  22  24  26  28  30 

  b=4 

  c=8    12    16    20    24 

  d=2    10     4    26 

 

注意：在元素访问中，若数组有 m 个元素，那么 a(i)访问的是第 i 个位置对

应的元素，i 必须在[1,m]这个范围内取值，否则都会出错。 

 

3. 数组元素的删除与增加 

(1) 删除数组中元素的格式为： 

     a(i)=[]  %删除数组 a 的第 i 个元素 

     a([i,j,k])=[] %删除数组 a 的第 i、j 和 k 个元素 

【例 3-9】 数组的删除 

在 MatLab 命令窗口输入>> a=[2,-1,3,9,5]; 

                     >> b=[1 3 5 7 9 11 13 15]; 

                     >> a(2)=[] 

                     >> b([2,3,4 5])=[] 

按 Enter 键输出结果为  a=2     3     9     5 

                     b= 1    11    13    15 

(2)  数组增加元素的格式为： 

a(i)=k   % k 为任意常数，i 的取值不同，那么这个式子表示的意义也

不同。具体看例 3-10 

 

【例 3-10】 数组的增加 

在 MatLab 命令窗口输入>> a=[2,-1,3,9,5]; 

                     >> a(3)=10 

按 Enter 键输出结果为  a= 2   -1    10   9   5  

在 MatLab 命令窗口输入>> a=[2,-1,3,9,5]; 

                     >> a(6)=10 

按 Enter 键输出结果为  a= 2   -1    3    9   5   10 

在 MatLab 命令窗口输入>> a=[2,-1,3,9,5]; 
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                     >> a(9)=10 

按 Enter 键输出结果为  a= 2   -1    3    9   5   0    0    0   10 

 

4. 数组的拼接 

在计算中，可能会对两个数组或者更多个数组拼接在一起构成一个新

的数组，MatLab 数组拼接的格式为： 

x=[b,c d]  %b、c、d 三个数组拼接构成一个新数组 

注意：数组必须放在中括号“[ ]”中，数组之间用空格或逗号间隔 

【例 3-11】 b、c、d 三个数组拼接构成一个新数组 

在 MatLab 命令窗口输入>> b=4 

                    >> c=8    12    16    20    24 

                    >> d=2    10     4    26 

                    >> x=[b,c d] 

按 Enter 键输出结果为 x=4  8  12  16  20  24  2  10  4  26 

 

5. 数组的运算 

在数组的运算中，很多运算符都要两个数组同阶才，所以本书数组都

是默认按行表述的，若按列表述需进行转置即可，下面介绍数组的运算。 

（1）数组转置 

数组转置就是行列互换，即列的数组转置后就变成行的数组，用单引

号“‟”表示，其调用格式为： 

b=a‟  %对数组 a 进行转置，然后赋值给 b 

（2）数组的长度 

数组的长度指数组中元素的个数，调用格式为： 

m=length(a)  %数组 a 的长度（元素的个数），并赋值给 m 

（3）数组中所有元素之和 

对数组中所有的元素求和，其调用格式为： 

s=sum(a)  %对数组 a 中所有元素求和，并把结果赋值给 s 

（4）数组中最大（小）值 

找任一数组中的最大值和最小值，其调用格式为： 

ma=max(a)  %数组中的最大值，并赋值给 ma 

mi=min(a)  %数组中的最小值，并赋值给 mi 

 

【例 3-12】 求数组 a=linspace(2,18,5)的长度和元素之和。 

在 MatLab 命令窗口输入>> a=linspace(2,18,5) 

                     >> m=length(a) 

                     >> s=sum(a) 
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                     >> ma=max(a) 

                     >> mi=min(a) 

 

按 Enter 键输出结果为 a=2     6    10    14    18 

                    m=5 

                    s=50 

                    ma=18 

                    mi=2 

                  

设两个同阶数组 A=(a1，a2，„，an)，B=(b1，b2，„，bn)，数组 A 与

B 可进行加、减、乘、除和乘方运算，运算符及其表达式格式如下： 

（5）数组的加、减法运算 

数组的加、减法就是对应元素相加、相减，调用格式为 

A+B   % A+B=(a1+b1, a2+b2, …, an+bn) 

A-B    %A-B=(a1-b1, a2-b2, …, an-bn) 

（6）数组的乘、除和乘方运算 

MatLab 中数组的乘、除和乘方运算也是对应位置元素进行相乘、相除

和乘方运算，这几类运算符需在符号前加上一个点“.”，所以也叫做点运

算。调用格式为： 

A.*B  % )*,,*,*(*. 2211 nn bababaBA   

A./B  % )/,,/,/(/. 2211 nn bababaBA   

A.^B  % ),,,(.^ 21

21
nb

n

bb
aaaBA   

【例 3-13】 数组的加、减、乘、除、乘方运算。 

在 MatLab 命令窗口输入>> A=[2 5 8 15]; 

                        B=[1 10 4 3]; 

                        c1=A+B 

                        c2=A-B 

                        c3=A.*B 

                        c4=A./B 

                        c5=A.^B 

按 Enter 键输出结果为 c1= 3    15    12    18                     

                     c2=1    -5     4    12 

                     c3=2    50    32    45 

                     c4=2.0000    0.5000    2.0000    5.0000 
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                     c5= 2     9765625        4096        3375 

 

2.3.3  矩阵及其运算 

 

1. 矩阵的创建 

MatLab 创建矩阵的方法有： 

（1）直接输入创建矩阵 

与数组的直接构建类似，直接列举所有的元素，所有元素必须放在中

括号“[ ]”里面，同一行元素与元素之间有空格（空格数不限）或逗号间

隔，不同行的元素用分号“;”进行换行。 

【例 3-14】 在 MatLab 中创建矩阵























82

50

12

A 。 

在 MatLab 命令窗口输入>> A=[2,-1;0,5;-2  8] 

按 Enter 键输出结果为    A=  2    -1 

                            0     5 

                           -2     8 

（2）创建特殊矩阵 

MatLab 中常用的特殊矩阵包括零矩阵、单位矩阵、全是 1 的矩阵和空

矩阵，其调用格式为： 

A=[]  %生成一个空矩阵 A 

B=zeros(m,n)  %生成一个 m 行 n 列的零矩阵 

C=ones(m,n)  %生成一个 m 行 n 列元素全是 1 的矩阵 

D=eye(m,m)  %生成一个 m 行 m 列单位矩阵 

 

2. 矩阵元素的操作 

MatLab 中矩阵元素的操作与数组操作大致相同，其调用格式表示的意

义如下： 

A(i,j)  %访问矩阵 A 中第 i 行第 j 列的元素 

A(i,j)=2  %矩阵 A 中第 i 行第 j 列的元素用 2 代替 

A(i,:)  %访问矩阵 A 中第 i 行的元素 

A(i,:)=2  %矩阵 A 中第 i 行元素都用 2 代替 

A(i,:)=[]  %删除矩阵 A 中第 i 行元素 

A(:,j)  %访问矩阵 A 中第 j 列的元素 

A(:,j)=2  %矩阵 A 中第 j 列的元素都用 2 代替 

A(:,j)=[]  %删除矩阵 A 中第 j 列的元素 
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C=[A,B]  %矩阵 A 与矩阵 B 水平拼接 

D=[A;B]  %矩阵 A 与矩阵 B 垂直拼接 

【例 3-15】 矩阵 






















90

73

52

01
BA ，  

在 MatLab 命令窗口输入>> A=[1,0;-2 5]; 

                     >> B=[3,7;0,-9]; 

                     >> C=A(2,1) 

                     >> D=A(:,2) 

                     >> E=B(1,:) 

                     >> F=[A,B] 

                     >> G=[A;B] 

按 Enter 键输出结果为     C= -2 

                        D= 0 

                           5 

                        E= 3     7 

                        F= 1     0     3     7 

                          -2     5     0    -9 

 

                        G= 1     0 

                          -2     5 

                           3     7 

                            0    -9 

3. 矩阵的运算 

在矩阵的运算中，同阶矩阵才可以做加减法运算，A 乘 B 要满足矩阵

A 的列数与矩阵 B 的行数相等。 

（1）矩阵转置 

矩阵转置就是行列互换，用单引号“‟”表示，其调用格式为： 

B=A‟  %对矩阵 A 进行转置，然后赋值给 B 

（2）矩阵的阶（行数与列数） 

矩阵的阶指矩阵行数和列数，调用格式为： 

[m,n]=size(A)  %矩阵 A 的行数和列数，行数赋值给 m，列数赋值给 n 

（3）矩阵中元素之和 

对矩阵中元素求和，其调用格式为： 

a=sum(A)  %对矩阵 A 中各列元素求和，并把结果赋值给 a 

b=sum(A,2)  %对矩阵 A 中各行元素求和，并把结果赋值给 b 

c=sum(sum(A))  %对矩阵 A 中所有元素求和，并把结果赋值给 c 
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（4）矩阵中最大值和最小值 

任一矩阵最大值或最小值的调用格式为： 

max(A)  %矩阵 A 各列的最大值 

max(max(A))  %矩阵 A 的最大值 

min(A)  %矩阵 A 各列的最小值 

min(min(A))  %矩阵 A 的最小值 

 

【例 3-16】 已知























82

50

12

A ，求 A 的转置、阶、和 

在 MatLab 命令窗口输入>> A=[2,-1;0,5;-2  8]; 

                     >> B=A‟ 

                     >> [m,n]=size(A) 

                     >> a=sum(A) 

                     >> b=sum(A,2) 

                     >> c=sum(sum(A)) 

按 Enter 键输出结果为    B= 2     0    -2 

                          -1     5     8 

                            m=3 

                            n=2 

                            a=    0    12 

                            b=  1 

                                5 

                                6   

                            c=12 

（5）矩阵的初等运算 

MatLab 在矩阵常用的初等运算如表 2-8 所有 

表 2-8  MatLab 矩阵的初等运算符 

名称 MatLab 运算符 MatLab 表达式 

加 + A+B 

减 - A-B 

乘 * A*B 

除 / 或 \ A/B 或 A\B 

幂 ^ A^B 
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【例 3-17】 求 






















90

73

52

01
BA ， 的加、减、乘、除和幂运算 

 

２.４ 符号运算 

在数学、工程和经济等科研工作中经常遇到函数问题，因此本节介绍

MatLab 符号运算功能。 

 

2.4.1 符号表达式 

 

符号表达式包括符号函数和符号方程，两者的区别是：前者不包括等

号，后者必须有等号。创建符号表达式的格式为: 

（1） 单引号表示 

‘符号函数或符号方程’  %符号函数或符号方程比须写在单引号里面 

（2） 用 syms 定义符号变量，若有多个符号变量，变量之间用空格间隔，

且独占一行。这种定义变量法不能用来创建符号方程。其格式为： 

syms x y z  %定义了 x，y，z 三个符号变量 

【例 3-20】 在 MatLab 输入 xy sin 和 22  yx  

方法 1 

在 MatLab 命令窗口输入>> y='sin(x)' 

                     >> 'x^2+y=2' 

方法 2 

在 MatLab 命令窗口输入>> syms x  

                     >> y=sin(x) 

2.4.2 符号表达式的运算 

 

微积分是大学生数学的基础内容，本节介绍 MatLab 求函数值、函数极

限、导数、积分的运算命令。 

（1） 求函数值 

subs(f,old,new)  %用 new 代替函数 f 中的 old 变量 

注意：这里的 new 可以是常量也可以是变量，若是变量必须先定义这个符

号变量。 

【例 3-21】 已知 532)( 2  xxxf ，求 )2(f ， )(af  

在 MatLab 命令窗口输入>> syms x a  

                    >> f=2*x^2+3*x-5; 
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                    >> subs(f,x,-2) 

                    >> subs(f,x,a) 

（2） 函数极限运算 

在 MatLab 中，用 limit 命令来求解极限，格式如下： 

limit(f,x,a)  % 计算变量 x 趋于 a 时函数 f 的极限 

limit(f,x,b,'left/right')  % 计算变量 x 趋于 b 时函数 f 的左或右极限 

注意：在 MatLab 中无穷用 inf 表示 

【例 3-22】 求极限
x

ex

x 
lim 和 xx

x
lnlim

0
 

在 MatLab 命令窗口输入>> syms x 

                       limit(exp(x)/x,x,+inf) 

                       limit(x*log(x),x,0,'right') 

 

（3） 函数求导运算 

在 MatLab 中，函数的导数用 diff 命令实现，格式如下： 

diff(f,x,n)  % 对函数 f 的变量 x 求 n 阶导数 

【例 3-23】 已知函数 6xy  ，求 y和 )4(y  

在 MatLab 命令窗口输入>> syms x 

                       y=x^6; 

                       y1=diff(y,x,1) 

                       y2=diff(y,x,4) 

按 Enter 键输出结果为 y1= 6*x^5 

                    y2= 360*x^2 

（4） 函数的积分运算 

在 MatLab 中，函数的积分用 int 命令实现，格式如下： 

int(f,x)  % 对函数 f 的变量 x 求不定积分 

int(f,x,a,b)  % 对函数 f 的变量 x 求在区间[a,b]上的定积分 

注意：用 int 求不定积分时，运算结果不会显示常数 C。 

【例 3-24】 求 dxx )1( 2

  和  
2

1

2 )1( dxx  

在 MatLab 命令窗口输入>> syms x 

                       y=x^2+1; 

                       y1=int(y,x) 

                       y2=int(y,x,-1,2) 

按 Enter 键输出结果为 y1= 1/3*x^3+x 
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                    y2= 6 

 

2.4.3 解方程组 

 

方程组广泛用于生产活动和科学技术问题中。MatLab 求解线性方程组

简单快速。 

1. 方程的求解 

MatLab 求解方程的命令是“solve”，其调用格式为 

solve(„y‟)  %求解方程 y 

solve(„y‟,‟x‟)  %求解方程 y 中的 x 变量 

x=solve(„y‟,‟x‟)  %求解方程 y 中的 x 变量，并将结果赋值给 x 

【例 3-18】 解方程 012 x  

在 MatLab 命令窗口输入>>x= solve('x^2-1=0','x') 

按 Enter 键输出结果为    x= 1 

                          -1 

2. 方程组的求解 

MatLab 求解方程组的命令也是“solve”，其调用格式为 

    [x1,x2,„ ,xn]=solve(„y1‟,‟y2‟,„ ,‟yn‟,‟x1‟,‟x2‟,„ ,‟xn‟)  %解方程组

y1,y2,„,yn 

【例 3-18】 解方程组










06

06

2

2

xy

yx
 

在 MatLab 命令窗口输入>>[x,y]=solve('x^2+y-6=0','y^2+x-6=0','x','y') 

按 Enter 键输出结果为    x= 2 

                          -3 

                          1/2-1/2*21^(1/2) 

                          1/2+1/2*21^(1/2) 

                           y= 2 

                             -3 

                             1/2+1/2*21^(1/2) 

                             1/2-1/2*21^(1/2) 

3. 线性方程组的求解 

方程组都可用“solve”命令求解，但是若为线性方程组还可用下列方

法求解，下列方法的求解需将线性方程组写成矩阵形式 
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BAX

bxaxaxa

bxaxaxa

bxaxaxa

mnmnmm

nn

nn





























2211

22222121

11212111

 

其中





















mnmm

n

n

aaa

aaa

aaa

A









21

22221

11211

，





















mx

x

x

X

2

1

，





















mb

b

b

B

2

1

 

MatLab 求解线性方程组的调用格式为： 

X=A\B  % 反除法 

X=rref(C)  % 初等行变换求解，这里的 C=[A,B] 

【例 3-19】 解线性方程组














73

822

1732

yx

zyx

zyx

 

解法 1：用“solve”命令求解 

在 MatLab 命令窗口输入>>  

       [x,y,z]=solve('x+2*y+3*z=17','2*x-y+2*z=8','x+3*y=7','x','y','z') 

按 Enter 键输出结果为 x=1  y=2  z=4 

解法 2：反除“\”法 

先将线性方程组写成矩阵形式：AX=B，其中 



















031

212

321

A ，



















3

2

1

x

x

x

X ，



















7

8

17

B  

在 MatLab 命令窗口输入>> A=[1 2 3;2 -1 2;1 3 0]; 

                       B=[17;8;7]; 

                       X=A\B 

按 Enter 键输出结果为 X=1 

                       2 

                       4 

 

解法 3：矩阵初等变换求解 

在 MatLab 命令窗口输入>> A=[1 2 3;2 -1 2;1 3 0]; 

                       B=[17;8;7]; 
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                       C=[A,B]; 

                       X=rref(C) 

按 Enter 键输出结果为 X=  1     0     0     1 

                         0     1     0     2 

                         0     0     1     4 

 

 

 

２.4 图形功能 

图形是 MatLab 的主要功能之一，直观的图形更能体现数据的特征。本

节主要介绍 MatLab 的二维图及三维图命令，包括着色、线型、点标、网格、

多图绘画等功能。 

 

2.4.1 二维图形常用的命令 

在 MatLab 绘图过程中常用到的一些命令包括颜色、线型、点标、网格

等，下面先介绍常用的一些命令： 

1. 常用的命令 

为使图形的表达更准确、使人一目了然，便于数据资料的对比、分析

和全面了解。MatLab 绘图时，往往需要插入坐标、标题、网格、图形叠加

和多张图等操作，对应的调用命令格式如下： 

xlabel('坐标名称')  % 插入 x 坐标名称，必须写在单引号中，可以写文字 

ylabel('坐标名称')  % 插入 y 坐标名称 

zlabel('坐标名称')  % 插入 z 坐标名称 

title('标题内容')  % 插入标题，标题必须写在单引号中，可以写文字 

axis([xmin xmax ymin ymax])  % 坐标控制 

legend('内容 1','内容 2')  %绘制曲线的图例 

text(xt,yt,'注释内容')  %在图里(xt,yt)坐标处书写字符注释. 

grid on  % 显示网格 

grid off  % 关闭网格 

hold on  % 保持当前图形，下一张图形叠加在当前图形中 

hold off  % 退出图形叠加 

subplot(m,n,p)  % 图形分割为 m*n 个，m 行 n 列的第 p 个绘图区域 

 

2. 图形设置样式 

修改图形的颜色、点标或线型更利于数据图形的对比。MatLab 中颜色

选项见表 2-9，点标选项见表 2-10，线型选项见表 2-11。 
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表 2-9   MatLab 绘图颜色表 

颜色名称 MatLab 表示  颜色名称 MatLab 表示 

黄色 y  绿色 g 

洋红色 m  蓝色 b 

青色 c  白色 w 

红色 r  黑色 k 

 

表 2-10   MatLab 绘图点标表 

点标名称 MatLab 表示  点标名称 MatLab 表示 

实心点 .  向下三角形△ ^ 

“o”（字母 o) o  向下三角形▽ v 

“x” x  向左三角形◁ < 

+ +  向右三角形▷ > 

* *  五角星☆ p 

方形□ s  六角星 

 

 

h 

菱形◇ d    

 

表 2-11  MatLab 绘图线型表 

线型名称 MatLab 表示  线型名称 MatLab 表示 

实线 -  点划线 -. 

虚线 :  长虚线 -- 

 

 

2.4.2 二维图形 

二维图的绘制是 MatLab 图形处理的基础，常见二维图中有柱形图、散

点图、曲线图、面积图等，下面着重介绍几类二维图的作图命令。 

 

1. 柱形图 

柱形图的 MatLab 调用格式为： 

bar(x,y)  % 画 x 和 y 的柱形图，默认颜色是深蓝色 

bar(x,y,'b')  % 画 x 和 y 的柱形图，'b'中的 b 表示蓝色(见表 2-11) 

 

【例 3-20】 某班 110 个学生的数学成绩统计见表 2-9，请根据表格数据作
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成绩分组与学生人数的柱形图。 

表 2-9  110 个学生数学成绩统计表 

成绩分组 50~60 分 60~70 分 70~80 分 80~90 分 90~100 分 

学生人数 12 15 27 32 24 

【MatLab 命令】 

x=50:10:90;  %输出 x 数据 

y=[12,15,27,32,24];  %输出 y 数据 

bar(x,y,'b')  % 画 x、y 的柱形图，颜色为蓝色 

xlabel('成绩分组')  % 插入成绩分组作为 x 坐标 

ylabel('学生人数')  % 插入学生人数作为 y 坐标 

 

【输出结果】见图 2-1 

50 60 70 80 90
0

5

10

15

20

25

30

35

成绩分组

学
生

人
数

 

图 2-1  学生成绩统计柱形图 

 

2. 散点图 

 

分析数据规律或发展趋势时常常需画数据的散点图，其 MatLab 调用格

式为： 

scatter(x,y)  % 画 x 和 y 的散点图，默认是蓝色 o 形图 

scatter(x,y,'ms')  % 画 x 和 y 的散点图，'ms'中的 m 表示颜色中的洋红

色（见表 2-11），s 表示点标选项中的方形□（见表 2-12），这两个可选项

也可这样表示'sm'。 

 

【例 3-21】 有一个对温度敏感的电阻，现测得一组温度 x 与电阻 y 的数据

如表 2-10 所示，请根据表中数据作 x 与 y 的散点图。 

表 2-10  温度与电阻的测量数据 

温度 x(℃) 20.5 32.7 51 73 95.7 
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电阻（Ω） 765 826 873 942 1032 

【MatLab 命令】 

x=[20.5  32.7  51  73  95.7];   %输出 x 数据 

y=[765, 826, 873, 942, 1032];  %输出 y 数据 

scatter(x,y)  % 画 x、y 的散点图，颜色和点标是默认值 

scatter(x,y,'ms')  % 画 x、y 的散点图，颜色为洋红色，点标为方形□ 

xlabel('温度 x')  % 插入温度 x 作为 x 坐标 

ylabel('电阻 y')  % 插入电阻 y 作为 y 坐标 

 

【输出结果】见图 2-2 

20 40 60 80 100
750

800

850

900

950

1000

1050

温度x

电
阻

y

20 40 60 80 100
750

800

850

900

950

1000

1050

温度x

电
阻

y

 

图 2-2  温度 x 与电阻 y 的散点图 

 

3. 曲线图 

MatLab 常用的曲线图作图命令为 plot 和 fplot。其中，plot 命令常用于

向量或矩阵的列来绘图，而 fplot 则是画在某一区间上的函数图。命令调用

格式如下： 

plot(x,y)  % 以 x 向量为横坐标，以 y 向量为纵坐标的二维曲线图 

plot(x,y,'r:*')  % 画 x 和 y 向量的曲线图，'r:*'中为颜色、线型及点标

可选项，可选项可指定 1 项或 2 项或 3 项均可。若'r:*'中不指定线型，即'r*'

只有点标和颜色，则图形为散点图 

fplot('y',[a,b])  % 画函数 y 在区间[a,b]上的二维曲线图 

fplot('y',[a,b],'r:*')  % 'r:*'中为颜色、线型及点标可选项 

 

绘图需注意以下几点： 

① 向量 x 的输入参见 2.3.2 节中的数组创建法输入 

② 若 y 为向量，以①相同；若 y 是函数，则函数中的“乘、除和幂”

运算都要带上“.”运算。 

③ 向量 x 与 y 的阶要相同方能绘图 
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【例 3-22】 画函数 y=2sinx
2 在区间[0,π]上的图形 

【MatLab 命令】 

x=0:pi/50:pi;  % 冒号“:”法输入 x 向量，且步长为 pi/50 

y=2.*sin(x.^2);  % 函数 y，输入时注意“乘、除和幂”运算都要带上“.”运算 

subplot(2,2,1)  %  2 行*2 列(4 个)绘图区域，当前图形画在第 1 行第 1 列(第 1 个）位置 

plot(x,y)  % 用 plot 命令画 x 与 y 的二维图，默认蓝色和实线 

xlabel('x')  %  x 坐标轴命令为 x 

ylabel('y')  %  y 坐标轴命令为 y 

title('figure 1')   %  标题命令为 figure 1 

 

x=0:pi/50:pi; 

y=2.*sin(x.^2); 

subplot(2,2,2)  %2 行*2 列(4 个)绘图区域，当前图形画在第 1 行第 2 列(第 2 个）位置 

plot(x,y,'mp')  % 画 x 与 y 的二维图，颜色为洋红色，点标为五角星☆号 

xlabel('x')  

ylabel('y') 

title('figure 2')   %  标题命令为 figure 2 

 

x=linspace(0,pi,50); 

y=2.*sin(x.^2); 

subplot(2,2,3)  %2 行*2 列(4 个)绘图区域，当前图形画在第 2 行第 1 列(第 3 个）位置 

plot(x,y,'r:o')  % 画 x 与 y 的二维图，红色，虚线、o 型点标 

xlabel('x')  

ylabel('y') 

title('figure 3')  %  标题命令为 figure 3 

 

subplot(2,2,4) 

fplot('2*sin(x^2)',[0,pi],'g-.')   % 用 fplot 命令画绿色的点划线二维图 

xlabel('x')  

ylabel('y') 

title('figure 4')  %  标题命令为 figure 4 

【输出结果】见图 2-3 
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图 2-3  y=2sinx
2 在区间[0,π]上的图形 

 

4. 图形的叠加 

在比较两个函数图形时，更希望这两个函数图形叠加在同一张图上；

分段函数的图形也是要将多个函数画在同一张图上。MatLab 用于图形叠加

的命令为 hold on，横坐标范围不相同也可用。其具体使用见例 3-23。 

 

【例 3-23】 在同一张图上画函数 y=x
2
+2,[-2,0]与 y=2

x,[0,2]上的图形 

【MatLab 命令】 

x=linspace(-2,0,20); 

y=x.^2+2; 

plot(x,y,'r:o') 

hold on    %  图形叠加，在当前图形上继续画下一张图 

x=0:0.075:2; 

y=2.^x; 

plot(x,y,'d-') 

xlabel('x') 

ylabel('y') 

title('y=2^x 和 y=x^2+2 的图形') 

legend('y=x^2+2','y=2^x')    % 绘制曲线的图例 

text(-1,4,'y=x^2+2')  %在图中(-1,4) 坐标处以 y=x
2
+2 为注释 

text(1,3,'y=2^x')   %在图中(1,3) 坐标处以 y=2
x为注释 

hold off   % 退出图形叠加 
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【输出结果】见图 2-4 
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图 2-4  y=x
2
+2，[-2,0]与 y=2

x，[0,2]叠加的图形 

 

5. 其它二维图命令 

MatLab 除了上面介绍的柱形图、散点图和曲线图这三类二维图形外，

还有一些常用的二维图命令，下面给出这些命令的调用格式，方便读者了

解及查阅，见表 2-11 

表 2-11  MatLab 其它二维图命令 

命令调用格式 功能 

polar(t,r) 绘制极坐标图形，t 为角度，r 为幅度向量 

area(x,y) 面积图，x 向量为横坐标，y 向量为纵坐标 

pie(y) 饼图，y 中每个元素占总元素和的百分比图 

contour(Z) 等高线，矩阵 Z 的等值线图 

 

MatLab 具有很齐全的作图命令，更多作图命令参看专门的 MatLab 工

具书。 

 

2.4.3 三维图形 

1. 空间曲线图 

    与二维图作图命令 plot 相似，MatLab 提供了 plot3 命令绘制三维曲线

图，若画叠加图形用 hold on 命令。调用格式如下 

plot3(x,y,z)  % 画向量 x、y 和 z 的三维曲线图 

plot3(x,y,z,'r:*')  %  'r:*'中为颜色、线型及点标选项 
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【例 3-24】 画 x=sin(z)，y=cos(z)，z∈[0,10π]图形 

【MatLab 命令】 

 

clf     %  清除图形窗口中的图形 

z=0:pi/20:10*pi; 

x=sin(z); 

y=cos(z); 

plot3(x,y,z,'-.*') 

xlabel('x') 

ylabel('y') 

zlabel('z') 

 

【输出结果】见图 2-5 
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图 2-5  x=sin(z)，y=cos(z)，z∈[0,10π]的三维曲线图形 

 

2. 空间曲面图 

MatLab 绘制三维曲面图形的常用命令有 mesh 和 surf。用这两个命令时

常常用到 meshgrid 命令，meshgrid 用于生成网格（二维）采样数据点。调

用格式如下： 

mesh(x,y,z)  % 生面 x、y 和 z 的三维曲面图 

surf(x,y,z)  % 生面 x、y 和 z 的三维曲面图 
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【例 3-24】 画 z=sin(x)cos(y)，x,y∈[0,2π]曲面图 

【MatLab 命令】 

clf 

x=0:pi/20:2*pi; 

y=0:pi/20:2*pi; 

[x,y]=meshgrid(x,y); 

z=sin(x).*cos(y); 

subplot(1,2,1) 

mesh(x,y,z) 

xlabel('x') 

ylabel('y') 

zlabel('z') 

title('mesh') 

  

[x,y]=meshgrid(0:pi/20:2*pi); 

z=sin(x).*cos(y); 

subplot(1,2,2) 

surf(x,y,z) 

xlabel('x') 

ylabel('y') 

zlabel('z') 

title('surf') 

 

【输出结果】见图 2-6 
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图 2-6  z=sin(x)cos(y)，x,y∈[0,2π]曲面图 

 

2.4.4  图形窗口控制 

MatLab 图形的输出单独显示在专门图形的窗口中，进入图形窗口界面
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可对图形进行复制、保存等操作，同时还可以对图形进行一些简单的修饰，

如图形的大小、颜色、字体的大小、插入 x、y 或 z 坐标、标题、文本等，

灵活操作图表窗口，调整修饰图形会使图形更美观。 

MatLab 图形窗口界面见图 2-7 

 

图 2-7  MatLab 图形窗口界面 

常用到的图形操作总结如下： 

1. 单击图 2-7 中的 show plot tools（绘图工具），进入图形操作界面； 

2. 图形的大小通过调整图形显示窗口界面的大小选择合适的比例及大小； 

3. 图形窗口常用的操作包括 

 

表 2-12  MatLab 绘图工具操作步骤 

操作名称 操作步骤 

复制图像 单击菜单中 Edit → Copy Figure 

插入 x 坐标 单击菜单中 Insert → Xlabel 

插入 y 坐标 单击菜单中 Insert → Ylabel 

插入 z 坐标 单击菜单中 Insert → Zlabel 

插入标题 单击菜单中 Insert → Title 

插入文本 单击菜单中 Insert → TextBox 

插入图例 单击菜单中 Insert → Legend 

字体大小、颜色 选中字体 →  Font → Font Size(大小)/Colors(颜色) 

线型、粗细、颜色 选中曲线 →  Line → 改线型、粗细、颜色 

点标、大小、颜色 选中点标 → Marker → 改点标、大小、（填充）颜色 

 

MatLab 图形工具里还有很多操作，具体的读者可以自己体会，熟练使

用图形工具，会让图形更美观。 
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２.６ 程序设计 

MatLab 常用的控制结构语句包括条件语句（又称选择语句）结构和循

环语句结构。进行程序设计时常常用到关系运算及逻辑运算，本节重点介

绍程序设计的控制语句结构。 

 

2.6.1 M 函数文件 

M 函数文件具有参数传递功能，易于函数的调用。常用 MatLab 软件编

程的学者都会建立自己的 M 函数文件。M 函数文件的调用格式为： 

 

function [输出结果 1,输出结果 2,„]=函数名(输入变量 1,输入变量 2,„) 

语句体 

 

注意以下几点： 

① 输出结果：只有一个时，可以不用中括号； 

② 函数名：必须按变量的命名规则命名； 

③ 保存 M 文件时，必须以函数名为文件名，即该函数文件命名为“函数

名.m”。必须保存在 MatLab 软件安装路径下的 word 文件夹中，才能调用

该函数。 

④ 在 MatLab命令窗口中输入：[输出结果 1,输出结果 2,„]=函数名(输入变

量 1,输入变量 2,„)即可调用该函数，但是函数名后面的小括号里面的输入

变量必须写出具体的数值。 

 

2.6.2 关系运算符与逻辑运算符 

 

1. 关系运算符 

MatLab 有 6 种关系运算符（见表 2-13），用来判断两个元素的关系是

否正确，只有真和假两个结果：“1”代表 true（真）；“0”代表 false（假）。 

 

表 2-13  关系运算符及 MatLab 表示 

运算符名称 MatLab 表示 

 

运算符名称 MatLab 表示 

小于 < 大于 > 

小于等于 <= 大于等于 >= 

等于 == 不等于 ~= 

 

2. 逻辑运算符 

MatLab 包含 3 个逻辑运算符，分别为：“&”与（and）、“|”或（or）
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和“~”非（not）。其运算结果也只有“1”（真）和“0”（假）两个，具

体运算规则见表 2-14。 

 

表 2-14  MatLab 逻辑运算符运算规则 

a b a&b a|b ~a 

1 0 0 1 0 

1 1 1 1 0 

0 0 0 0 1 

0 1 0 1 1 

 

2.6.3 条件语句结构 

 

MatLab 中能实现条件控制结构语句有 if 和 switch。这两个语句常用于

判断是否满足条件，从而确定下一步语句的选择。 

 

1. if 语句结构 

由于实际问题的条件数不同，则 if 语句结构也稍有不同，以下分三种

情况描述 if 语句结构。 

①  单分支 if 语句结构 

单分支 if 语句是最简单的 if 语句结构，用于 1个条件的情况，其调

用格式为： 

 

功能解释：如果条件表达式为真，则执行语句体；最后跳出结构结束。 

 

②  双分支 if 语句结构 

双分支 if 语句结构用于两个条件的情况，其调用格式为： 

 

if  条件表达式 

    执行语句体 

end 

 

%  if 与条件表达式之间空格间隔，占一行； 

%  执行语句体可以是 1 个或多个语句； 

%  必须以 end 结束，end 占一行。 
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if  条件表达式 1 

执行语句体 1 

else 

执行语句体 2 

end 

 

%  用于 2 个选择条件的情况； 

%  else 自占一行，且后面不用写出第 2 个条件表达

式，表示除了条件表达式 1 以外的都执行语句体 2。 

%  以 end 结束，end 占一行 

 

功能解释：如果条件表达式 1 为真，则执行语句体 1；否则条件表达式

1 为假，则执行语句体 2；最后跳出结构结束。 

 

【例 3-25】 给定任意两个数 a 和 b，c 等于大的数除以小的数,计算 c 

 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

 

function  [c]=calc(a,b)  %M 文件 

if a>b 

    c=a/b; 

else 

    c=b/a; 

end 

 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

[c]=calc(2,10) %或者输入 

a=2; 

b=10; 

[c]=calc(a,b)  

 

【输出结果】在 MatLab 命令窗口显示输出结果 

 

c=5 

 

③  多分支 if 语句结构 

多分支 if 语句结构用于两个以上条件的情况，其调用格式为： 
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if  条件表达式 1 

执行语句体 1 

elseif  条件表达式 2 

执行语句体 2 

       …… 

elseif  条件表达式 n-1 

执行语句体 n-1 

else 

执行语句体 n 

end 

 

%  用于 3 个及 3 个以上条件的情况； 

%  elseif 是连着写中间无空格； 

%  else 自占一行，且后面不写出条件表达式 

%  以 end 结束 

 

功能解释：如果条件表达式 1 为真，则执行语句体 1；否则判断条件表

达式 2，若真，则执行语句体 2；否则再判断条件表达式 3，若真，则执行

语句体 3；否则再判断后面的条件表达式，直到判断完所有的条件表达式就

结束跳出结构。 

 

【例 3-26】 已知
















0          ,

10         ,2

1    ,1

)(

3

2

xx

xx

xx

xf ，求任意 x 的值 

 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

 

function  f=calx(x)  %M 文件 

if  x>1 

    f=x^2+1; 

elseif x>0&x<=1  %  MatLab 中不能连着写 0<x<=1，需写 x>0&x<=1 

    f=2*x; 

else 

    f=x^3; 

end 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

f=calx(-2) %或者输入 
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x=-2; 

f=calx(x)  

 

【输出结果】在 MatLab 命令窗口显示输出结果 

 

f=-8 

 

2. switch 语句结构 

MatLab 中 switch 语句与 if 语句的不同在于，当其中一个条件为真时，

就不会再对后面的条件进行判断。相当于说 switch 的所有条件中只有一个

是真的。switch 常与 case 一起控制，其调用格式为： 

switch  开关表达式 

case  表达式 1 

执行语句体 1 

case  表达式 2 

执行语句体 2 

       …… 

case  表达式 n-1 

执行语句体 n-1 

otherwise 

执行语句体 n 

end 

 

%  若开关表达式满足表达式 1，则执行语句体 1，

然后结束跳出。若开关表达式不满足表达式 1，但

满足表达式 2，则执行语句体 2，然后结束跳出；

若开关表达式既不满足表达式1也不满足表达式2，

则判断是否满足下一个表达式，直到找到满足的表

达式，则执行对应的语句体，然后结束跳出。 

%  otherwise 后面不写表达式，独占一行 

%  end 独占一行 

 

 

【例 3-27】 学生成绩分数与等级的转换，转换规则见表 2-15 

 

表 2-15  成绩分数（分）与等级的转换 

学生成绩分数 x（分） 对应等级 

90 ≤ x ≤ 100 优秀 

80 ≤ x < 90 良好 

70 ≤ x < 80 中等 

60 ≤ x < 70 及格 

 x < 60 不及格 

 

问题：请编程实现任一成绩的等级。 
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【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

 

function  f=scorex(x)  % M 文件 

switch  x 

    case  num2cell(90:100)  % 若只有一数值，直接写，如 case 80 

        f='优秀'; 

    case  num2cell(80:89)  % 若直接写全部数值，不需用 num2cell 

        f='良好'; 

    case  num2cell(70:79) 

        f='中等'; 

    case  num2cell(60:69) 

        f='及格'; 

    otherwise 

        f='不及格'; 

end 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

f=scorex(83)   % 或者输入 

x=83; 

f=scorex(x)  

 

【输出结果】在 MatLab 命令窗口显示输出结果 

 

f=良好 

 

2.6.4 循环语句结构 

在循环语句中，被反复执行的语句称为循环语句体。每循环一次，都

必须先判断是继续执行循环，还是结束执行跳出循环结构。MatLab 语言提

供 for 和 while 两个循环命令。 

 

1. for 循环语句结构 

for 循环的特点在于：循环次数知道，且知道循环变量的初值、终值和

步长。其调用格式为： 
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for k=x:b:y 

循环语句体 

end 

 

%  k 是循环变量，x 是循环初值，y 是循环终值，b

是步长，步长为 1 时可省略，即 k=x:y  

%  k 从初值 x 开始进入循环，每执行一遍循环语句

体后，k=k+b，直到 k=y，执行最后一遍循环语句体，

然后跳出循环结构 

 

【例 3-28】 编程对任意一个数组的所有元素求和 

 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

 

function  y=sumarray(a)  %  M 文件 

sa=length(a);  %  数组 a 的元素个数 

y=0;  %  初始化 

for k=1:1:sa    

    y=y+a(k);    %  循环语句体 

end 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

y=sumarray(randint(1,10,[0 100]))  %  或者输入 

a=randint(1,10,[0 100]);  %  随机生成 0 到 100 之间的 1 行 10 列的整数数组 

y=sumarray(a)  

 

【输出结果】在 MatLab 命令窗口显示输出结果，因为数组是随机生成的，

所以每次结果都不一样。 

 

2. while 循环语句结构 

 

while 循环的特点在于：循环次数不确定，依据条件表达式的逻辑值来

判断是否继续执行循环语句体。其调用格式为： 
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while  条件表达式 

循环语句体 

end 

 

%  功能注释及注意事项 

%  若条件表达式为真时，执行循环语句体，若条

件表达式为假时，则跳出循环结构 

%  以 end 结束，end 占一行 

 

【例 3-29】 对 1 到 100 的偶数相加。 

【MatLab 命令】在 MatLab 命令窗口输入 

 

y=0; 

for k=2:2:100 

    y=y+k; 

end 

y 

 

 

y=0; 

k=2; 

while k<=100 

    y=y+k; 

    k=k+2; 

end 

y 

  

【输出结果】在 MatLab 命令窗口显示输出结果 

 

y=2550 

 

2.6.5  MatLab 编程实例 

 

【例 3-30】 求任意一个数组的最大值，并记录最大值所在的位置。 

 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

 

function  [amax,aloc]=findmax(a)  %  M 文件 

sa=length(a);  %  数组 a 的元素个数 

amax=a(1);  %  初值，选定数组 a 的第一个元素就是最大值 amax 

aloc=1;   %  最大值所在的位置 aloc，即第一个元素 

for k=1:sa 

    if a(k)>amax 

        amax=a(k);  %  最大值的替换 

        aloc=k;   %  当前最大值的位置 

    end 

end 
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【MatLab 命令】在 MatLab 命令窗口输入 

 

[amax,aloc]=findmax(randint(1,10,[0 100]))  %  或者输入 

a=randint(1,10,[0 100]);  %  随机生成 0 到 100 之间的 1 行 10 列的整数数组 

[amax,aloc]=findmax(a)  

 

【输出结果】在 MatLab 命令窗口显示输出结果，因为数组是随机生成的，

所以每次结果都不一样。 

 

【例 3-31】 求任意一个矩阵的最大值，并记录最大值所在的位置。 

 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

 

function [Amin,Aloc]=fAmax(A) 

a=size(A);  % 矩阵 A 阶，即行数、列数 

Amin=A(1,1);  % 假设矩阵 A 的第 1 行第 1 列元素是最小的 

Aloc=[1,1];  %  矩阵 A 最小值所在的位置 Aloc，即第 1 行第 1 列 

for i=1:a(1) 

     for j=1:a(2) 

           if A(i,j)<Amin 

               Amin=A(i,j); 

               Aloc=[i,j]; 

           end 

    end 

end 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

[Amin,Aloc]=fAmax(randint(3,5,[0 100]))  %  或者输入 

a=randint(3,5,[0 100]);  %  随机生成 0 到 100 之间的 3 行 5 列的整数数组 

[Amin,Aloc]=fAmax(a)  

 

【输出结果】在 MatLab 命令窗口显示输出结果，因为矩阵是随机生成的，

所以每次结果都不一样。 
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【例 3-32】 编程求函数 21232)( 23  xxxxf 在区间[-3,2]的最小值的解

析解。 

【分析】 求函数的最小值可以先求导，然后解出驻点，再找出最小值；也

可以直接用命令求解。这里用解析法编程求解。 

 

【MatLab 命令】在 MatLab 命令窗口输入 

x0=-3;  %  x 区间的左端点 

fmin=2*x0^3+3*x0^2-12*x0-2;  % 假设在 x=-3 取最小值 

for x=-3:0.1:2   

    f=2*x^3+3*x^2-12*x-2; 

    if f<fmin 

        fmin=f; 

        x0=x; 

    end 

end 

[x0,fmin] 

 

【输出结果】在 MatLab 命令窗口显示输出结果 

ans=1 -9 

 

【例 3-33】 韩信点兵问题：韩信带 1500 名兵士打仗，站 3 人一排，多出 2

人；站 5 人一排，多出 4 人；站 7 人一排，多出 6 人。请计算还有多少兵？ 

 

讨论 1：增加一个条件，战死四五百人 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

function m=fnumber1 

for k=1000:1100 

    if mod(k,3)==2&mod(k,5)==4&mod(k,7)==6 

        m=k; 

    end 

end 

【MatLab 命令】在 MatLab 命令窗口输入 

 

m=fnumber1  %  或直接按运行键 
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【输出结果】在 MatLab 命令窗口显示输出结果 

m=1149  %  只显示一个数值 

 

讨论 2：若没有战死四五百人这个条件，则满足题目的数据有 14 个，用

MatLab 编程如下： 

 

【M 函数文件命令】建立 M 函数文件，在 M 文件中输入 

function m=fnumber(n) 

m=[];  %  空矩阵 

for k=1:n   %  n 为原来总数 

    if mod(k,3)==2&mod(k,5)==4&mod(k,7)==6 

        m=[m,k];  % 把满足条件的数值存放于 m 矩阵中 

    end 

End 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

m=fnumber(1500)  %  或者输入 

n=1500;  %  原来总数为 1500 

m=fnumber(n) 

 

【输出结果】在 MatLab 命令窗口显示输出结果 

 

m= 104  209  314  419  524  629  734  839   944  1049  1154  1259 

   1364    1469 

 

２.７ MatLab 与外部文件数据之间的传递 

 

实际问题的数据大多存放在 txt 文本或 Excel 文件中，不管是逐个数据

输入或输出，还是利用 Windows 中的“复制”和“粘贴”命令来实现数据

传递，对于庞大的数据来说都是不可取的。本节介绍利用函数实现 MatLab

与外部文件数据之间的传递。 

 

2.7.1 MatLab 与 txt 文件数据之间的传递 

MatLab用 load函数从文本数据文件中读取数据，用diary函数把MatLab

中的数据写入文本文件中。 
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1. load 函数 

load 函数的调用格式如下： 

 

load filename.txt  % 导入文本名为 filename 的记事本数据，txt 为记事本的后缀 

 

注意：在导入前，先将 txt文本命名为 filename，然后把该文本复制到

MatLab 安装路径下的子目录名为 word 的文件夹中。导入后，用文件名

filename 来访问数据。 

 

2. diary 函数 

diaty 函数的调用格式如下： 

 

diary('filename.txt')  % 将数据输出到文本名为 filename 的 txt 文件中 

 

注意：运行该命令后，MatLab会在word文件夹中自动建立名为 filename

的文本文件，并在其中记录该程序运行的结果 

 

【例 3-34】 现有 10 个学生的数学成绩存放在 txt 文件中（见表 2-16），调

用 txt 文件数据，并求成绩的平均分，并将平均成绩输出到 txt 文件中。 

 

表 2-16   10 个学生数学成绩 

编号 1 2 3 4 5 6 7 8 9 10 

成绩 76 42 94 97 72 88 55 96 62 83 

 

导入数据步骤： 

第一步：重命名记事本，命名时要符合 MatLab 变量命名规则，如本例文本

重命名为 score； 

第二步：把文件 score.txt 复制到 MatLab 安装路径的子目录名为 word 的文

件夹中（见图 2-8）； 

第三步：在 MatLab 程序中输入 load score.txt 即可导入 score.txt 文本中的数

据，导出后，用 score 来调用数据。 

 



 
 41 

 

图 2-8  score.txt 文本复制到 word 文件夹中 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

load score.txt  % 导入 score 文档文本的全部数据 

score_size=size(score);   % 计算 score 数据的阶 

score_sum=0; 

for k=1:score_size(2) 

   score_sum=score_sum+score(2,k); 

end 

score_avg=score_sum/score_size(2)   % 计算平均数，将结果赋值给 score_avg 

diary('score_avg.txt') 

 

【输出结果】在 MatLab 的 work 文件夹中，自动生成一个名为 score_avg

的文本，将运行结果记录在该文本中（见图 2-9）。 

 

图 2-9  diary 输出在 score_avg 文本的结果示意图 
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2.7.2 MatLab 与 Excel 文件数据之间的传递 

 

MatLab 用 xlsread 函数实现 Excel 文件的数据的导入，用 xlswrite 把数

据输出到 Excel 文件中。 

1. xlsread 函数 

xlsread 函数的调用格式如下： 

 

a=xlsread('score.xls');  % 导入名为 score 的 Excel 文件第一个工作表的全部数

据，导入后，以 a 来调用 score 中的数据 

b=xlsread('score.xls','sheet2');  % 指定导入 score 文件中的名为 sheet2 表的全部

数据，将数据赋值给 b 

c=xlsread('score.xls','sheet1','单元格区域');  % 导入 score中名为 sheet1表中的

指定单元格区域 

 

注意： 

①  在导入前先将命名为 score 的 Excel 文件复制到 MatLab 安装路径下的

子目录 word 文件中； 

② .xls 为 Excel 文件的后缀名； 

③  若 score 中有多个不同工作表，指定某个工作表的全部数据时，用第 2

种调用格式，注意工作表的命名是否一致； 

④  指定某个表中某个区域的数据时，用第 3 种调用格式。数据单元格区

域的 MatLab 表示为：左上角数据的位置:右下角数据的位置，如 A2:D13 表

示由第 A 列第 2 行到第 D 列第 13 行数据区域。 

 

2. xlswrite 函数 

xlswrite 函数的调用格式如下： 

 

xlswrite('filename.xls',[输出变量 1,输出变量 2])   

 

注意：运行该命令前，必须在 MatLab 安装路径的子目录 word 文件夹

中新建立名为 filename 的 Excel 文件，然后才能使用 xlswrite 函数记录输出

列表的数据。 

 

【例 3-35】 现有 10 个学生的数学成绩存放在 Excel 文件中（见图 2-10），

调用 Excel 文件数据，求成绩的平均分，并记录在 Excel 文件中。 
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图 2-10  score.xls 文件中的数据 

 

导入数据步骤： 

第一步：重命名 Excel 文件，命名时要符合 MatLab 变量命名规则，如本例

文本重命名为 score； 

第二步：把文件 score.xls 复制到 MatLab 安装路径的子目录 word 文件中（见

图 2-8） 

第三步：xlsread('score.xls')直接导入 score.xls 的全部数据。 

第四步：在 MatLab 安装路径的子目录 word 文件中新建一个名为 score_avg

的 Excel 文件。 

 

【MatLab 命令】在 MatLab 命令窗口输入 

 

a=xlsread('score.xls');  %  将 score 文件第 1 个工作表(默认）的全部数据赋值给 a 

a_size=size(a); 

a_sum=0; 

for k=1:a_size(2) 

    a_sum=a_sum+a(2,k); 

end 

a_avg=a_sum/a_size(2); 

xlswrite('score_avg.xls',[a_sum,a_avg]) 

 

【输出结果】a_sum 和 a_avg 的数据会输出在 MatLab 安装目录 word 文件

夹名为 score_avg 的 Excel 文件中（见图 2-11）。 
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图 2-11  score_avg 文件的输出数据 

 

调用图 2-10 中的 10 名学生的成绩的方法有三种，调用格式如下： 

 

a=xlsread('score.xls')   %  默认导入 score 的第 1 个工作表的全部数据 

a=xlsread('score.xls','data1')   %  导入 score 中名为 data1 工作表的全部数据 

a=xlsread('score.xls','data1','B1:K2')  

 %  导入 score 中名为 data1 工作表中指定第 B 列第 1 行到第 K 列第 2 行的数据 

 

说明：不管是调用 txt 文档文本数据还是 Excel 表中数据，MatLab 都不

引用“非法”（如文字）数据。如上例在调用数据时，没有调用第一列的

学生编号和成绩（分）。 

注意：MatLab 数据都是以矩阵形式存放的，所以在 Excel 或 txt 文档中

存放的数据也要按矩阵形式存放。 

 

2.7.3  MatLab 的 Array Editor 

 

MatLab 是计算或编程的一个工具，不管输入还是输出的数据都能在子

窗口 Workspace 中找到，双击 Workspace 中选定的文件名就能打开 Array 

Editor 见图 2-12。 
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图 2-12  查看 Workspace 中存放的数据 

 

Array Editor 的用法： 

① 打开 Array Editor 可检查数据调用是否正确和完整； 

② 可直接在 Array Editor 中复制数据； 

③ 可对 Array Editor 中的数据进行快速绘图（见图 2-13）。 

 

 

 

图 2-12  Array Editor 的简单操作 

 

2.8 MatLab 创新奖 

 

全国大学生数学建模竞赛组织委员会与北京 MathWorks 公司（MatLab

软件生产商）达成合作协议，自 2013 年起，在每年竞赛中选出“MatLab

创新奖”两份（本科、专科组各一份）。 

MatLab 创新奖具体获奖要求： 

（1）能够恰当、灵活、自如地使用 MatLab 进行典型数学建模问题的求解，

包括数据处理、求解微分方程和规划模型等； 

（2）能够自主编写结构化函数，正确使用函数句柄，优化 MatLab 程序结

构，使用 MatLab 程序既简洁又高效； 

（3）能够熟练、正确应用 MatLab 程序的基本语法结构，包括变量的定义、
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循环语句的编写、内置函数的调用等。 

MatLab 创新奖获奖程序赏析： 

1. 2015 年乙组 MatLab 创新奖程序--D 题 

clc,clear 

c=[0.4 0.6 0.5 0.6 0.7 0.8 0.9 0.6 0.2 0.3 0.4];  % 满意率 

a=[77 98 117 145 156 167 178 126 0 0 0];  % 房屋面积 

b=2.28*102077.6; % 最大允许建筑面积 

lb=[50 50 50 150 100 150 50 100 50 50 50];  % 最小房型套数 

ub=[450 500 300 500 550 350 450 250 350 400 250];  % 最大房型套数 

[x,fval]=fmincon(„obj‟,lb,a,b,[],[],lb,ub) 

X=round(x); % 四舍五入取整 

sum(x‟) % 求和 

 

 

 

 

 

 


